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Introduc t ion

When you work with print providers  
who have a Xerox® iGen® 5 Press with 
the 5th print station, you have the 
opportunity to create designs that go 
beyond CMYK. 

You can offer your clients on-brand spot colors 
using Orange, Green, or Blue inks that extend the 
press’s color gamut, as well as design digital print 
enhancements using Xerox® Fluorescent Yellow,  
White, and Clear Dry Inks, all without sacrificing  
digital print’s turnaround time and cost-effectiveness. 
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This guide will walk you 
through several ways to 
design for the 5th print 
station. Best practices for 
file preparation are included 
to help ensure print results 
match your design intent.

All steps included in this 
guide assume a working 
knowledge of Adobe® 
Creative Suite applications. 

Always work with your  
print provider on specific  
file attributes and PDF 
export settings.

+
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The 5th print station functions differently depending on the 
specific ink it holds and how that ink is used within a design.

When the 5th print station is used with Orange, Green,  
or Blue (gamut-extending colors), that color will layer  
with the CMYK Dry Inks to extend the gamut of the press 
and prints to your paper in a single pass.

Fluorescent Yellow, White, and Clear Dry Inks, 
however, are used for different purposes (spot and 
photo enhancements) and do not extend the gamut  
of the press. This means their printing process is 
somewhat different. 

The 5th pr int  s tat ion process .

Helpful terms:

Passes – The number of times a sheet of paper or other 
media runs through the imaging transfer point.

Ink Layers – The number of hits of ink that are required  
to meet the desired print characteristics for each job.
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Single Pass 

Designs that place Orange, Green, Blue, Fluorescent 
Yellow, or Clear Dry Ink elements as a spot or next to 
CMYK will print in one single pass. 

Designs that place Orange, Green, Blue, or Fluorescent 
Yellow Dry Ink elements over CMYK will print in one 
single pass. 

Designs that use White only as a spot will print in one 
single pass. 

Single  pass  vs .  Mult ipass .
THE 5TH PRINT STATION PROCESS

Media

Spot
5th Color Only Next to CMYK

Over CMYK

White Dry Ink 
(single pass) 

Media

CMYK 
(single pass)

Media

Orange Dry Ink 
(single pass) 
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Multipass

When a White element is next to, over, or under  
CMYK*in a design, the ink will print in a separate  
pass from your four color process elements. This 
separate pass is invisible to the casual observer as it’s 
happening automatically within the press, but it is 
important to understand.

Due to slight paper movement between the passes, small 
adjustments should be made to graphics calling for White 
Dry Ink to ensure the final printed product matches your 
design intent. Those adjustments will be covered in the 
following pages.

When White is specified as a double hit** over or  
under CMYK, the ink will print in a separate pass.

Media

Double Hit**

* Automatic Multipass mode required. 
** Manual mode required. This requires a second file for the second hit.

Double Hit**
Over CMYK
Single Hit*

Under CMYK
Single Hit*

Media

White Dry Ink 
(first pass) 

CMYK 
(second pass) 

Media

White Dry Ink 
(first pass) 

White Dry Ink  
(second pass - optional) 

CMYK 
(third pass) 



Be spot-on with  brand colors . 
GAMUT EXTENSION WITH 5TH COLOR

The need to accurately represent your clients’ brand colors can 
often be the determining factor when deciding between offset  
and digital. Now, the iGen® 5 Press can be your go-to press.

An optional 5th color extends the 
iGen® 5 Press gamut to put more  
of your clients’ brand colors in reach. 

By adding Orange, Green, or Blue  
to CMYK Dry Inks in an iGen® 5 Press, 
more than 93% of the PANTONE® 
PLUS swatch book can be accurately 
reproduced. This makes digital print  
a highly relevant option for jobs that 
need fast, cost-effective turnaround—
in addition to on-brand color. 

8



Using the 5th color capability is easy. Once you have selected a PANTONE® color, you 
can quickly check to see if it would benefit from the addition of Orange, Green, or Blue 
by using the iGen® 5 Press Gamut Extension Tool: xerox.com/gamut.

Simply enter your PANTONE® PLUS color and the tool will let you know if it can be 
accurately represented by CMYK, or if it would benefit from the addition of a 5th color.

In this case, with the addition of 
Orange, the specified PANTONE® color 
would be a “very accurate match.”

While a 5th color could be used to match 
this desired PANTONE® color, CMYK alone 
will also provide a “very accurate match.”

9



Determine whether your PANTONE® 
selection will benefit from a 5th color 
using the Gamut Extension Tool: 
xerox.com/gamut.

Using 5th co lor  in  your  f i les .
GAMUT EXTENSION WITH 5TH COLOR

Once you know your PANTONE® PLUS color will benefit from Orange, Green, or Blue, you simply need to 
define it as a Spot color in your layout file. Your print provider—and the iGen® 5 Press—will do the rest.

When you hand your job off for production, be sure to tell your print provider to run it with a 5th color,  
and to ask for a press proof. This will help ensure the result matches your intent. 

10

1  In Adobe® InDesign®, add the 
desired PANTONE® color to your 
file. Designate it as a spot color.

2   Fill your shape with the new  
 PANTONE® color swatch.

  Save your file and export as a  
high-resolution Adobe® PDF using 
the instructions on the next page.

1

2



Prepar ing PDF fi les  for  pr int ing.

Exporting as a high-res PDF from Adobe® InDesign®.
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4

2

3

1  From the main menu, select:  
File > Adobe PDF Presets >  
Press Quality, and click Save.

2  Select General: Compatibility >  
and choose Adobe® Acrobat® 7 
or higher. 

3  On the lower-right side, check 
Create Acrobat Layers. 

4  Select Compression: Color Images > 
Do Not Downsample. 

 Compression > JPEG,  
Image Quality > Maximum. 

 Choose the same for Grayscale 
Images. For Monochrome Images > 
CCITT Group 4.

1



Extend the gamut of your photos.
GAMUT EXTENSION WITH 5TH COLOR

CMYK Only

A depiction of where the press would enhance the image 
with Orange Dry Ink.
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NOTE: The gamut enhancement is enabled on the print job 
submission side and there is nothing a designer would have to 
do to prep a photograph other than using an image that would 
benefit from gamut extension. See page 13 for examples.
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Orange 021 C

CMYK+ Orange
The gamut extension capability can boost the tonal range 
of your photographs beyond the CMYK gamut. Shown 
above is an example of an image that would benefit from 
Orange gamut extension.



Each of the examples above would benefit from pushing the Orange 
gamut. They depict subjects or contain elements in the right color space, 
and that are already naturally bold, vivid, and attention-grabbing. 

The examples above would not 
benefit from Orange gamut 
extension. Generally speaking, 
memory colors—or those we 
associate from life experience—
should be left as close to 
natural as possible, unless being 
manipulated for creative  
or editorial purposes.

Similarly, the items shown here 
would not benefit from Orange 
gamut extension unless the 
designer intends to manipulate 
the color space and change the 
natural depiction of the scenes  
or objects. 
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Objects or scenes inhabiting the correct color space and 
depicting an appropriate color palette—which could  
be made more vivid or striking without diminishing  
realism—are ideal candidates for gamut extension.

Unless it’s for a specific artistic, creative, or editorial  
purpose, realistic depictions of items the viewer expects 
to see portrayed in a specific color (memory color)  
are not good candidates for gamut extension.

For example, a butterfly, garment, or item that is a vivid 
orange in nature would be enhanced by extending its 
orange gamut. An item or scene that is less vivid—or  
that appears dull, yellowish, or rusty-colored in real life— 
would not.

We’ve used CMYK+Orange here, but the same principles 
apply to Green and Blue. 

Things to consider when selecting good images:
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Eye-stopping specialty effects 
with Fluorescent Yellow Dry Ink.

XEROX® FLUORESCENT YELLOW DRY INK

Go beyond neon colors to an 
ink that actually glows.

Fluorescent Yellow Dry Ink prints with a 
unique, high-visibility hue that captures 
attention and even fluoresces—or glows—
under UV light. Use it for spots, floods,  
or photo enhancements.

15

How to incorporate Fluorescent Yellow Dry Ink into your designs:
Over CMYK
Single Hit

Spot
Fluorescent Yellow Only Next to CMYK

Media
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XEROX® FLUORESCENT YELLOW DRY INK

Fluorescent Yellow can be printed next to CMYK as a spot or flood effect.

Fluorescent Yellow next to CMYK 
will make text and visual elements 
pop. In this example, it is used as a 
background flood along with heavy 
black text to create an attention-
grabbing safety sign.

Media

Single Pass Ink Layers

CMYK 
(single pass) 

Fluorescent Yellow 
Dry Ink  

(single pass) 
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Fluorescent Yellow can also be printed over CMYK to enhance images and add more value to jobs.

Incorporate Fluorescent Yellow 
tints over lighter areas in a photo or 
graphic to add high-energy impact 
and creative flair.

Media

CMYK 
(single pass) 

Fluorescent Yellow Dry Ink  
(single pass) 

Single Pass Ink Layers



Get the most from Fluorescent Yellow Dry Ink.
XEROX® FLUORESCENT YELLOW DRY INK

Designing with light tints of 
Fluorescent Yellow can enhance CMYK 
and/or create eye-catching effects.

Avoid serifs and small point text 
with Fluorescent Yellow Dry Ink.

Avoid using Fluorescent Yellow for 
applications that will be exposed to 
direct sunlight. It is recommended to 
use it for indoor applications—not for 
outdoor use.

Avoid using tints of Fluorescent 
Yellow for text or fine lines. Using 
100% Fluorescent Yellow is the best 
way to boost legibility.

18

abc123 abc123
20% Fluorescent Yellow  

next to black ink.
100% Fluorescent Yellow 

next to black ink.



If the Fluorescent Yellow Dry Ink did 
not print as you intended, you may 
have to enable Multiply or Overprint  
for overlapping elements.

Graphics created in InDesign® will 
typically require Overprint to be used  
for optimal print results.

If Fluorescent Yellow Dry Ink isn’t 
printing at all, check that the custom 
spot is identified for each text/graphic 
with the same spelling in all cases (i.e., 
“Fluorescent Yellow”).

You can preview your file in Separation 
Preview within InDesign® or in Adobe® 
Acrobat® (Print Production > Output 
Preview) to make sure the Fluorescent 
Yellow elements are specified correctly.

Always request a hardcopy press proof to 
make sure printed results are matching 
your design intent.

In Adobe® InDesign®, Fluorescent 
Yellow text and graphics should be 
placed together on their own layer.

In Adobe® Illustrator®, all text and 
graphics (CMYK and Fluorescent 
Yellow) may be placed on a 
single layer. When saved out of 
Illustrator, these elements are 
automatically flattened down so 
multiple layers are unnecessary.

NOTE: Unless something is specified to 
overprint in Illustrator, it will knockout.

19

See page 20 for how-to examples.
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1  If you want a bitmap image to  
print in Fluorescent Yellow, you will 
need to begin with the image in 
Photoshop®. First, you’ll create  
or load your selection of the  
image area you’d like to make 
Fluorescent Yellow, then invert  
and delete the background.

2  If you’re starting with a color CMYK 
image, it will need to be converted  
to Grayscale. 

 To save as the correct file format,  
go to Menu and select Image,  
then Mode, then select Duotone.

 Select Type as Monotone. 

Preparing bitmap images with Adobe® Photoshop®.

3  Click on Ink 1 color, then choose  
RGB, and enter the following values: 
(R 222, G 255, B 0)*

4  Then select OK.

 * These RGB values best represent  
 Fluorescent Yellow.

2

1

Adding Fluorescent Yellow Dry Ink  
to your files.

20

XEROX® FLUORESCENT YELLOW DRY INK

3

4



6  Save your file so it is ready to  
be placed into an InDesign®  
layout file.

 Recommended file formats:  
Photoshop® DCS 2.0, PSD, EPS,  
and PDF.

 The file should bring in the color 
Fluorescent Yellow as a 100% 
Fluorescent Yellow spot color.

1  You can achieve this same  
result with another work process  
by creating a Spot Channel  
in Photoshop, naming it 
Fluorescent Yellow. 

2  Then save as a Photoshop  
DCS 2.0 file. You must embed  
the spot color and keep your 
naming convention the same.

SPOT CHANNEL NOTE:Preparing bitmap images with Photoshop®.

5  Select and rename the ink as  
Fluorescent Yellow, then  
select OK.

1

2

6

5

  The name “Fluorescent Yellow” is  
case-sensitive and should be used 
exactly as shown to ensure  
proper printing.

21



1  Create your vector graphics on  
a single layer in Illustrator.

Creating vector graphics with Adobe® Illustrator®.

 In the example shown, the Fluorescent 
Yellow Dry Ink will print next to the 
CMYK art.

Adding Fluorescent Yellow Dry Ink  
to your files.
Vector graphics that are created in Illustrator® can be placed into Adobe® InDesign®.

  The name “Fluorescent Yellow”  
is case-sensitive and should be  
used exactly as shown to ensure  
proper printing.

1

2
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XEROX® FLUORESCENT YELLOW DRY INK

2   Add a new color in the swatches 
palette to identify Fluorescent Yellow 
as a Spot Color. Go to the Swatches 
Palette, then New Color Swatch > 
Swatch Name, Type in Fluorescent 
Yellow, under Color Type > select 
Spot Color, under Color Mode, select 
RGB, and enter the following values:  
(R 222, G 255, B 0)*

 * These RGB values best represent  
 Fluorescent Yellow.



1  Create a new layer in  
InDesign® and name the  
layer Fluorescent Yellow.

2   Import Illustrator® .AI/.EPS  
graphics into InDesign® 
onto the designated  
Fluorescent Yellow layer.

Pulling it all together in InDesign®.

3  Import the Adobe® Photoshop® file 
into InDesign®, then choose Multiply. 

 Save your file and export as a  
high-resolution Adobe® PDF using  
the instructions on the next page.

Now that you have created your imagery for Fluorescent Yellow, you are ready to put it together in your final layout.

Within InDesign®, make sure that you place the CMYK elements on your CMYK layer. The elements that contain 
Fluorescent Yellow should be placed on your Fluorescent Yellow layer.

1

2 2

3 3

23



Prepar ing PDF fi les  for  pr int ing.

It’s important to choose the correct 
settings when saving a PDF for printing 
with Fluorescent Yellow Dry Ink. 

Follow these steps to create a PDF 
preset for saving high-res PDFs right 
out of InDesign®.

Exporting as a high-res Adobe® PDF from Adobe® InDesign®.

2

3

1  From the main menu, select:  
File > Adobe PDF Presets >  
Press Quality, and click Save.

2  Select General: Compatibility >  
and choose Adobe® Acrobat® 7  
or higher. 

3  On the lower-right side, check 
Create Acrobat Layers. 

24

XEROX® FLUORESCENT YELLOW DRY INK

1
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5  Set up with Crop Marks and Bleeds if necessary.4  Select Compression: Color Images > 
Do Not Downsample. 

 Compression > JPEG,  
Image Quality > Maximum. 

 Choose the same for Grayscale 
Images. For Monochrome Images > 
CCITT Group 4.

5

Within Acrobat®, you can quality check your PDF layers before printing by 
viewing the file in the Print Production > Output Preview window.

25
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* Automatic Multipass mode required. 
** Manual mode required.  

This requires a second file for the second hit.



Enhance your designs with  
White Dry Ink.

XEROX® WHITE DRY INK

Adding White to your color 
palette lets you make a  
bigger visual impact.

Use White Dry Ink to add visual appeal  
and function to both colored and transparent 
media. Draw attention to graphics and 
emphasize images so they jump right off  
the page.

How to incorporate White Dry Ink into your designs:
Over CMYK
Single Hit* Single Hit*

Spot
White Only Next to CMYK Double Hit**

Under CMYK
Double Hit**

Media

27
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XEROX® WHITE DRY INK

White can be printed next to or under CMYK to enhance images and add more value to jobs.

White enhances designs that print  
on dark cover stock – such as the 
holiday card shown here – creating 
higher-value postcards, invitations, 
posters, direct mail, and more.

Media

White Dry Ink 
(first pass) 

CMYK 
(second pass) 

Multipass Ink Layers
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You can also choose to add a second print pass of White for more opacity.

Media

White Dry Ink 
(first pass) 

White Dry Ink  
(second pass - optional) 

CMYK 
(third pass) 

While one layer of White 
Dry Ink creates a look many 
clients are happy with,  
a second pass may be  
desired in some cases. This 
would require a second 
PDF file of the White only 
elements to allow for a 
second hit of White ink.

You may choose to test  
both options with press  
proofs before doing a full 
production run.

Multipass Ink Layers

Whether running one pass of White Dry Ink or two, applying a choke to the White box(es) under the  
CMYK photo will help ensure an excellent print result and avoid registration variation.

Be aware running a second pass may cause the paper to shrink as it passes through the fuser a second time.  
This may lead to additional registration variation. It is good practice to always test designs on your media.



XEROX® WHITE DRY INK

To create a bold look on dark media, create a design that only uses White Dry Ink.

White Dry Ink 

MediaWhite on its own creates dramatic 
effects on dark, heavy media, opening 
up new design possibilities for folders 
and collaterals.

30

Single Pass Ink Layers



 A choke or spread is NOT required for two passes of White elements.

You can also choose to add a second pass of White for more opacity.

If you have selected specific 
elements—like the type 
shown to the left—to print 
in more than one pass, you 
should create a separate file 
for just those to help ensure  
the added opacity is right 
where you want it.

31

White Dry Ink  
(image + type first pass) 

White Dry Ink  
(type second pass) 

Media

Multipass Ink Layers



In this example, we have choked the White so it does not  
spread beyond the CMYK elements.

XEROX® WHITE DRY INK

In certain applications, you can use White over CMYK to add an opaque background.

White creates new possibilities for 
window signage on transparent media. 
Depending on how the signage is being 
applied, White can be printed either 
under or over CMYK.

32

Media

White Dry Ink  
(second pass) 

CMYK 
(first pass) 

Multipass Ink Layers



In this example, we have spread the CMYK text to fully cover  
the White underlayer.

White can also be used under CMYK to make colors pop on dark stocks.

CMYK 
(second pass) 

White Dry Ink  
(first pass) 

White makes color pop on dark stocks, 
giving you a simple way to broaden 
the types of stocks you specify without 
giving up legibility or design impact.

33

Media

Multipass Ink Layers



Get  the  most  from White  Dr y  Ink .
XEROX® WHITE DRY INK

Designing with tints of White is not 
recommended for text. If screens of 
White are used, text legibility may suffer.

Avoid serifs and small point text 
with White Dry Ink.

Avoid trying to trap to or overlap 
White to CMYK text and graphics with 
serifs or thin details.

White Dry Ink is intended for spot 
usage and not for flood needs.

Avoid double hits of White Dry Ink 
with small point text, as well as  
fine lines and small graphics.

A faux fill can be added as a layer 
within your design file to simulate a 
colored stock. This can help you better 
visualize the design (remember to 
delete or hide this layer when creating 
the Adobe® PDF).

34

abc123 abc123

20% white on red paper 100% white on red paper



Be aware running a second pass may cause 
the paper to shrink as it passes through 
the fuser a second time. This may lead to 
additional registration variation. It is good 
practice to always test on your media. 

If the White Dry Ink did not print as you 
intended, you may have to enable Multiply 
or Overprint for overlapping elements or 
adjust your choke and spread settings.

If White Dry Ink isn’t printing at all,  
check that the custom spot is identified  
for each text/graphic with the same  
spelling in all cases (i.e., “White”).

You can preview your file in Separation 
Preview within Adobe® InDesign® or in 
Adobe® Acrobat® (Print Production > 
Output Preview) to make sure the White 
elements are specified correctly.

Always request a hardcopy press  
proof to make sure printed results  
match your design intent.
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See page 36 for how-to examples.

In Adobe® InDesign®, it is required 
that White text and graphics be 
placed together on their own layer. 
This is because you have the option 
of using White over or under CMYK.

In Adobe® Illustrator®, all text and  
graphics (CMYK and White) may be  
placed on a single layer. When saved  
out of Illustrator, these elements are  
automatically flattened down so  
multiple layers are unnecessary. 

NOTE: Unless something is specified  
to overprint in Illustrator, it will knockout.



1

4

If you want a bitmap image to print in 
White, you will need to begin with the 
image in Photoshop®. If you’re starting 
with a color CMYK image, it will need  
to be converted to Grayscale first.  
All Grayscale images then need to  
be inverted.

 Go to Menu and select Image, then 
Adjustments, then select Invert.

2  To save as the correct file format,  
go to Menu and select Image,  
then Mode, then select Duotone.

 Select Type as Monotone. 

3  Click on Ink 1 color, then choose  
the PANTONE® Solid Coated library.

Preparing bitmap images with Adobe® Photoshop®.

4  Select PANTONE Process Magenta,  
then select OK. 

2
3

Adding White  Dr y  Ink  to  your  f i les .
XEROX® WHITE DRY INK

36

1

1



1  You can achieve this same result 
with another work process by 
creating a Spot Channel in 
Photoshop® and naming it White. 

2  Then save as a Photoshop  
DCS 2.0 file. You must embed  
the spot color and keep your 
naming convention the same.

SPOT CHANNEL NOTE:

1

6  Save your file so it is ready to be 
placed into an Adobe® InDesign®  
layout file.

 Recommended file formats:  
Photoshop DCS 2.0, PSD, EPS,  
and PDF

 The file should bring in the color 
White as a 100% Magenta  
spot color.

Preparing bitmap images with Photoshop®.

5  Select and rename the PANTONE® 
Process Magenta as White, then 
select OK.

5 6

  The name “White” is case-sensitive  
and should be used exactly as shown  
to ensure proper printing.

37
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1  Create your vector graphics on 
designated layers in Illustrator®:  
one layer for CMYK, and one  
layer for White.

2   Add a new color in the swatches 
palette to identify 100% Magenta 
as White and name it White.

  Designate the Color Type as  
a CMYK Spot Color. 

Creating vector graphics with Adobe® Illustrator®.

3   Save out each layer as a .eps to be 
placed into your InDesign® file. 
 
In the example shown, the White layer 
needs to print under the CMYK art.

Adding White  Dr y  Ink  to  your  f i les .
XEROX® WHITE DRY INK

Vector graphics that are created in Illustrator® can be placed into Adobe® InDesign® and designated to print with White Dry Ink.

  The name “White” is case-sensitive  
and should be used exactly as shown  
to ensure proper printing.

1

2

3

NOTE: Another option is applying 
overprint to the White fill if it is printing 
over CMYK. You can use this method 
instead of Multiply in InDesign®.  
To apply in Illustrator®, choose  
Window > Attributes > Overprint.38



1  Create a new layer in InDesign®  
and name the layer White.

2   Import Illustrator .eps graphics  
into each designated layer within 
InDesign: one layer for CMYK,  
and one layer for White. Add a 
choke to the White layer.

Pulling it all together in InDesign®.

3  For graphics imported into InDesign®, 
choose Multiply; for those created 
within InDesign®, choose Overprint. 

 Save your file and export as a  
high-resolution Adobe® PDF using  
the instruction on the next page.

Now that you have created your imagery for White, you are ready to put it together in your final layout.

Within InDesign, make sure that you place the CMYK elements on your CMYK layer and the White elements on  
your White layer, then ensure you have applied the proper choke to the White elements.

1

2
3

39



Prepar ing PDF fi les  for  pr int ing.
XEROX® WHITE DRY INK

It’s important to choose the correct 
settings when saving a PDF for 
printing with White Dry Ink. 

Follow these steps to create a PDF 
preset for saving high-res PDFs right 
out of InDesign®.

Exporting as a high-res Adobe® PDF from Adobe® InDesign®.

2

3

1  From the main menu, select:  
File > Adobe PDF Presets >  
Press Quality, and click Save.

2  Select General: Compatibility >  
and choose Adobe® Acrobat 7®  
or higher. 

3  On the lower-right side, check 
Create Acrobat Layers. 
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4

5  Set up with Crop Marks and Bleeds if necessary.4  Select Compression: Color Images > 
Do Not Downsample. 

 Compression > JPEG,  
Image Quality > Maximum. 

 Choose the same for Grayscale 
Images. For Monochrome Images > 
CCITT Group 4.

5

Within Acrobat®, you can quality check your PDF layers before printing by 
viewing the file in the Print Production > Output Preview window.
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Add decorat ive  and secur ity  ef fec t s 
with  Clear  Dr y  Ink .

XEROX® CLEAR DRY INK

Emphasize important content 
and make an eye-catching 
impression that drives results.

The addition of Clear Dry Ink in the 5th print 
station expands the versatility of the iGen® 
5 Press and allows you to offer customers a 
distinctive selection of specialty embellishment 
options for additional impact.

How to incorporate Clear Dry Ink into your designs:
Spot
Clear Only Next to CMYK

Media



Get  the  most  from Clear  Dr y  Ink .
XEROX® CLEAR DRY INK

44

Clear Dry Ink is intended for spot 
usage and not for flood needs.

Clear Dry Ink shows best on  
silk-coated media. 

We do not recommend applying 
Clear Dry Ink over dark or  
saturated colors.

Full Page Full Page

In Adobe® InDesign®, it is required 
that Clear text and graphics be 
placed together on their own layer. 
This is because Clear will be used 
as a spot or next to CMYK and the 
layer should be placed above the 
CMYK layer.

NOTE: It is required to multiply Clear 
design elements.
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If the Clear Dry Ink did not print as 
you intended, you may have to enable 
Multiply or Overprint for overlapping 
elements or adjust your choke and 
spread settings.

If Clear Dry Ink isn’t printing at all, 
check that the custom spot is identified 
for each text/graphic with the same 
spelling in all cases (i.e., “Clear”).

You can preview your file in Separation 
Preview within Adobe® InDesign® or in 
Adobe® Acrobat® (Print Production > 
Output Preview) to make sure the Clear 
elements are specified correctly.

Always request a hardcopy press  
proof to make sure printed results  
are matching your design intent.

In Adobe® Illustrator®, all text and 
graphics (Clear and CMYK) may be  
placed on a single layer. When saved  
out of Illustrator, these elements are  
automatically flattened down so  
multiple layers are unnecessary. 

NOTE: Unless something is specified to 
overprint in Illustrator, it will knockout.



1  In InDesign®, add a second 
layer in the Layers palette  
for Clear Dry Ink. 

Name the new layer Clear. 

Setting up your Adobe® InDesign® file for printing with Clear Dry Ink.

2   Add a new color in the Swatches 
palette to identify 100% Magenta 
as Clear and name it Clear.

  Designate the Color Type as a 
CMYK Spot Color.

  Fill your shape with the new Clear 
color swatch.

  The name “Clear” is case-sensitive  
and should be used exactly as  
shown to ensure proper printing.

Adding Clear  Dr y  Ink  to  your  f i les .
XEROX® CLEAR DRY INK
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3   Import vector graphics, draw and 
fill a shape, or select text that will 
have the Clear Dry Ink applied. 
Make sure all elements you want 
to print with Clear are placed on 
the Clear layer. 
 
In the example shown, the  
Clear layer will print over the 
CMYK art. 

4  For graphics imported into 
InDesign®, choose Multiply; for 
those created within InDesign®, 
choose Overprint. 

 Save your file and export as a  
high-resolution Adobe® PDF using 
the instruction on the next page.

Within InDesign, make sure that  
you place the CMYK elements on your 
CMYK layer and the Clear elements 
on your Clear layer, then ensure 
everything is registered appropriately. 

If precise alignment is needed 
between CMYK and Clear elements,  
be sure to set choke or spread in  
your file.

NOTE: Another option is applying 
overprint to the Clear fill when it is 
printing over CMYK. You can use this 
method instead of Multiply in InDesign.  
To apply in Adobe® Illustrator®, choose  
Window > Attributes > Overprint.

Clear will always print over CMYK.
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It’s important to choose the correct 
settings when saving a PDF for 
printing with Clear Dry Ink.

Follow these steps to create a PDF 
preset for saving high-res PDFs right 
out of InDesign®.

48

Exporting as a high-res Adobe® PDF from Adobe® InDesign®.

1  From the main menu, select:  
File > Adobe PDF Presets >  
Press Quality, and click Save.

2  Select General: Compatibility >  
and choose Adobe® Acrobat® 7  
or higher. 

3  On the lower-right side, check 
Create Acrobat Layers. 

Prepar ing PDF fi les  for  pr int ing.
XEROX® CLEAR DRY INK

2

3

1
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4

5  Set up with Crop Marks and Bleeds if desired.4  Select Compression: Color Images > 
Do Not Downsample. 

 Compression > JPEG,  
Image Quality > Maximum. 

 Choose the same for Grayscale 
Images. For Monochrome Images > 
CCITT Group 4.

5

Within Acrobat, you can quality check your PDF layers before printing by  
viewing the file in the Print Production > Output Preview window.



Mult ipass  choke and spread adjustments .
Choke and spread are two adjustments that will help compensate for any slight movement of paper 
between multiple print passes. These adjustments create a small overlap that covers unwanted gaps, 
specifically when using Xerox® White Dry Ink. The adjustment you choose will depend on your design.

50

Choking makes an element smaller. It should be used on bottom layer elements 
that don’t need to be an exact size—for example, a White box under an image.

We recommend you choose a color to make the White and Clear effects easily identifiable within your files.  
In this guide, we will use 100% Magenta as that color.

In this case, the White area under 
the flowers is choked in slightly to 
compensate for small movements  
of the paper between passes.

The image then completely covers 
the White box under it.



Your design—along with the stock you’ve chosen and the specific iGen® 5 Press your print 
provider is running—will determine the exact amount of choke or spread needed. You should 
always request a press proof to ensure the results match your design intent.

51

Spreading makes an element larger. It should be used on top layer elements when 
retaining shape is more critical—for example, a CMYK logo over White Dry Ink.

Spreading the CMYK slightly will 
cover the bottom layer of White 
while retaining your intended design 
appearance on dark stocks. 

Any extra CMYK spread blends in with 
the dark background stock color.



The 5th print station allows 
you the flexibility to meet a 
wider variety of PANTONE® 
colors and elevate your 
prints with eye-catching 
appeal. With Xerox® 
Fluorescent Yellow, White, 
and Clear Dry Inks, you can 
easily design with enhanced 
creativity in mind. 

To learn more about Xerox® iGen® 5 Press, please contact 
your Xerox representative or visit xerox.com.

©2020 Xerox Corporation. All rights reserved. Xerox® and iGen® are trademarks of Xerox Corporation in the United 
States  and/or other countries. 3/20 BR28391 IG5GL-02UB

With one pr int  s tat ion,  you get 
vir tual ly  unl imited possibi l i t ies .



Xerox® iGen® 5 Press
Your digital printing world just got more flexible — and more profitable.A world of opportunity.

The print landscape we were all comfortable with for the last decade 
and more has undeniably changed. And, while that can seem 
daunting, today’s realities also open doors to very real opportunities.

F O L L O W  U S  O N  T W I T T E R

@XeroxProduction
twitter.com/XeroxProduction

S H A R E  Y O U R  T H O U G H T S

Digital Printing Hot Spot Blog
digitalprinting.blogs.xerox.com

T U N E  I N  O N  Y O U T U B E

Corporate Videos
youtube.com/xeroxcorp

L I K E  U S  O N  F A C E B O O K

facebook.com/XeroxCorp

Connect and learn more.

The changing world of printing.
Change creates opportunity. The growth of digital printing and shifts in customer demand  
toward shorter runs with variable information mean there is an opening for a print provider  
who is prepared to step in, step up, and satisfy more customers.  

But what does it mean to be ready for that opportunity? 

Learn more at xerox.com
©2017 Xerox Corporation. All rights reserved. Xerox®, Xerox and Design®, FreeFlow® and iGen® are trademarks of Xerox Corporation in the U.S. and/or other countries. 
08/17   BR21907   IG5FD-01UB  
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5  E Q U A L S  O N E  —  A  S I N G L E  P L AT F O R M .

The Xerox® iGen® 5 Press unites all the elements of the iGen® family in a 
single, configurable platform so you can choose the exact configuration you 
need to succeed. Press speed, number of colors, feeding, and finishing — all 
are integrated into an end-to-end solution as unique as the challenges and 
opportunities you face every day. Feeding + finishing4 or 5 colors

or

Press speed

C H A N G E :  E X H I B I T  B  —  I N C R E A S I N G  C A P A B I L I T I E S .

Yes, printing is changing — for the better. This brochure is an ideal example. 
In the not-too-distant past, it would have been impossible to produce this 
brochure effectively. The requirement of a 5th spot color would have  
called for an offset solution and a longer print run to make it cost-effective.  
And, the desired run length of exactly one — yours — would have been 
impossible using that production method. 

Today, it’s easy thanks to the Xerox® iGen® 5 Press.

PANTONE® color

P M S  
1 3 7

Short run

C H A N G E :  E X H I B I T  A  —  D E C L I N I N G  P R I N T  R U N  L E N G T H S ;  

M O R E  S H O R T  R U N  J O B S  P E R  D AY. 2

In the early days of digital, run lengths used to be in the thousands.  
You could essentially maintain an offset workflow because you only printed 
a few digital jobs a day. But shifting customer needs have changed the 
equation. Now, customers want runs in the hundreds — or less. That places 
completely different demands on you and the solution you count on to 
meet those customer needs. 

   Stay the same           Increase

  Do not offer               Decrease

100%

80%

60%

40%

20%

0%

45%

37%

11%

7%

<250

42%

41%

9%

8%

250  
to 

499

37%

47%

7%

9%

500  
to 

999

31%

52%

6%

11%

1000  
to 

2,499

20%

56%

6%
18%

2,500  
to  

4,999

13%

48%

8%

31%

5,000
to 

9,999

9%

35%

13%

43%

10,000 
to 

24,999

8%

26%

19%

47%

25,000 
to 

49,999

7%

22%

23%

48%

50,000>

Change the way your customers see digital 
printing — and the way they see you. They may 
view digital as being suitable only for a limited 
subset of jobs — but now, digital is a solution that 
increases capabilities and enables a wider variety 
of jobs, making you the go-to print provider. 

Increase productivity and profit. The more  
time you can spend printing without setup, 
manual calibration, and rework interruptions,  
the more profitable you become. A solution  
that builds simplicity and predictability into  
the equation keeps you in the black.

Offer the high-value options your customers 
want. Clients are looking to stand out with 
accurate brand colors, varied finished sizes, and 
specialty embellishment options. Having a 
digital solution with these capabilities — and 
more — can make you an essential partner.

2 Keypoint Intelligence / InfoTrends Beyond CMYK 2016
N = 417 Print Service Providers and In-plant Printers



Automatically  
better.
The Xerox® iGen® 5 is the  
most productive digital press  
on the market, thanks to 
unprecedented levels of 
automation and intelligence 
built into the press from  
end to end. This automation 
radically reduces setup, 
improves image quality, 
reduces labor costs, and  
drives more profitable 
turnaround times.

The impact is immediate 
and dramatic both in your 
print shop and on your 
bottom line. 

It’s an iGen® 5 world.
The Xerox® iGen® 5 Press is built for the changing world of printing so you can seize new, 
profitable opportunities. The industry’s most available and productive digital press platform offers 
enhanced and valuable capabilities — like a 5th print station for gamut extension and digital 
embellishments — giving you a compelling solution to the way our print world operates today. 

Maximize your digital investment.
The Xerox® iGen® 5 increases your capabilities through a combination of flexible 
platform attributes. We’ll help you select the options that will best drive your 
business so you get a press that’s supremely customized for today — as well as 
one that’s ready for future innovations.

T H I N K I N G  B I G  S TA R T S  H E R E  —  2 6 "  ( 6 6 0  M M )  S H E E T.

There has been a perception that 
digital printing offers a restricted 
range of jobs in part because of 
sheet size. But iGen® 5 runs up to 
a 26" (660 mm) sheet. 

That enables you to print more 
jobs more economically; unique 
applications such as 6-panel 
brochures, gatefold pamphlets, 
pocket folders, and eye-catching 
direct mail pieces. 

Gatefold Brochure
Finished Size 280x648 mm
1,500 per hour – 4/4

Pocket Folder, Vertical
Finished Size 216x305 mm
1,500 per hour – 4/4

Trifold Brochure, 3 Up
Finished Size A4
4,500 per hour – 4/4

Business Cards, 42 Up
Finished Size 89x55 mm
63,000 per hour – 4/4

Table Card, 10 Up
Finished Size 127x178 mm
15,000 per hour – 4/4

Postcard, 12 Up
Finished Size 102x152 mm
18,000 per hour – 4/4

E X PA N D  Y O U R  O P P O R T U N I T I E S  W I T H 

T H E  T H I C K  S T O C K  C A PA B I L I T Y.

Add the Thick Stock Capability and your opportunities 
grow even further to include point-of-sale displays, folding 
cartons, and other applications that benefit from high- 
caliper media up to 24 pt (610 microns).

5  M O R E  M O N T H S  W I T H  i G E N ® 5  —  

A U T O M AT I O N  A N D  P R O D U C T I V I T Y.

The iGen® family has always been about making a finite amount of time work harder for you. 
Because of its advanced automation, the Xerox® iGen® 5 delivers more production time — up 
to 40% more, which equals five more months of production time every year. When other print 
providers are producing 12 months of jobs in the next year, you can produce 17. 

Y O U ’ V E  G O T  A N  I M A G E  T O  U P H O L D  —  AT TA I N I N G  A N D 

M A I N TA I N I N G  O U T S TA N D I N G  I M A G E  Q U A L I T Y.

The process of achieving consistent, sellable image quality can be manually intensive with 
other digital production solutions. Print, calibrate, print, adjust, and print again. Our built-in 
automation makes it predictable and efficient. You can easily attain the excellent color you 
need and maintain it from shift to shift and press to press.

Automated Color 
Maintenance Tool: 
Automates linearization, 
calibration, and profiling 
for color consistency  
and accuracy one day  
to the next.

Auto Carrier 
Dispense: Combines 
dry ink and carrier, 
yielding consistent 
smoothness from the 
first print to the last.

Auto Density Control: 
Patented technology 
designed to detect streaks 
before they occur and 
digitally compensate for 
any inconsistencies without 
operator intervention. 

Object-Oriented Halftoning: 
When selected, the iGen® 5 uses 
Object Oriented Halftoning to 
render image and text elements 
differently to maximize quality. 
A 180-line screen is used for 
images to produce optimal 
smoothness. Text is rendered 
at a 250-line screen that is 
optimized for sharpness. This 
lets you provide stunning results 
without tradeoffs  
for critical jobs such  
as brochures 
and catalogs. 

Automated Image-on-
Paper Technology: Produce 
more varied short-run jobs 
with very precise image-on-
paper registration without 
losing time with each paper 
size change. 

 

Matte Dry Ink lets you better emulate the look of 
offset and produce a wider range of jobs — including 
photo books, and other keepsakes — by optimizing 
the uniformity of gloss appearance across highlights, 
midtones and shadows. It extends your job flexibility, 
providing a pleasing offset-like  
matte finish, particularly on  
uncoated or silk stocks.

iGen 150 Production Time 

Service 

Repair 

Quality Control 

Waiting for Press 

Paper Jam 

Planned Maintenance 

Consumable Change 

Press Error Waste 

Job Setup 

Morning Routine 

E X T E N D  Y O U R  G A M U T  A N D 

Y O U R  S P O T  C O L O R  R E A C H  —  

A D D  A  5 T H C O L O R .

The 5th print station allows you to quickly 
load Orange, Green, or Blue Dry Ink as  
a supplement to CMYK, extending the  
press’ gamut and making it easy to match  
a wider variety of PANTONE® colors —  
over 90% of the PANTONE® PLUS swatch  
book — so you can keep more of your print 
buyers on-brand. 

E L E VAT E  YO U R  P R IN T IN G 

C A PA BIL I T IE S  —  A D D  W HI T E 

T O  YO U R  C O L O R  PA L E T T E .

With Xerox® White Dry Ink in the 5th print 
station, you can add eye-catching appeal 
to applications such as business cards, 
greeting cards, invitations and folding 
cartons on colored specialty substrates. 
White also provides a functional layer  
to transparent media for retail signage, 
letting you hang an “Open for Business” 
sign up for a whole new line of work. 

E N H A N C E  C R E AT I V I T Y  

A N D  S EC U R I T Y  —  A D D  

C L E A R  D RY  IN K .

Create decorative spot varnish effects  
or apply a watermark using Xerox® Clear 
Dry Ink in the 5th print station. Clear’s 
gloss effect makes a high-value 
impression that enhances the design  
of virtually any digital print. As a 
watermark, Clear adds an extra level of 
security to tickets, passes, and more. 

Digital CMYK… plus.

A D D  O N E  P R I N T  S TAT I O N  —  A N D  G E T  V I R T U A L LY  U N L I M I T E D  P O S S I B I L I T I E S .

The opportunity for digital print gets significantly more compelling when embellishment is added to the picture. Incorporating a 5th print station 
into your Xerox® iGen® 5 Press enables you to hit more PANTONE® colors or apply a variety of specialty effects — all in-line — so you can meet 
growing demands. And, the demand is clearly here. According to InfoTrends, 54.3% of print providers surveyed are considering purchasing a digital 
printing device with some sort of enhancement in 2018.1

1 Keypoint Intelligence / InfoTrends Beyond CMYK 2016

T H E  L O O K  Y O U R  C U S T O M E R S  A R E 

L O O K I N G  F O R  —  M AT T E  D R Y  I N K .

Digital print enhancement volume is 
predicted to grow at a 27% CAGR from 
2015 to 2020, reaching 25 billion 
pages by 2020. 

Print buyers indicated they are 
willing to pay a premium of 24% 
to 89% over CMYK only for digital 
print enhancements.

25B 89%
Print service providers’ profit margins 
on digital print enhancement can be 
very high (50% to 400%), resulting in a 
quick return on investment (ROI).

400%

T H E  R I G H T  F I N I S H I N G  T O U C H E S  —  

X E R O X ® I N T E G R AT E D P L U S  F I N I S H I N G  S O L U T I O N .

X E R O X ® F R E E F L O W ® C O R E  —

A U T O M AT E D  S P E E D .

You’re not just in the business of printing. 
You’re in the business of speed. That’s  
why it is so important that you think 
outside the box and consider the value  
of every step in the print process.

When you combine the efficiency of the  
iGen® 5 with the power of FreeFlow® Core, 
getting more color options doesn’t  
mean losing more prepress time. You can 
quickly and easily set up workflows using 
Xerox® FreeFlow® Core to automatically 
prepare files for print, taking touchpoints 
out of your process and running more jobs 
with your press.

The right finishing solution is crucial to 
accepting a wide range of jobs and producing 
them to your customers’ satisfaction. Xerox® 
IntegratedPLUS Finishing Solution extends  
the convenience and cost effectiveness of 
automatic finishing to multiple printers — 
including Xerox® and non-Xerox® printers in  
the same shop. It eliminates the need for  
highly skilled prepress operators and does  
away with manual programming, boosting 
efficiency on every job. 


